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1. Introduction 
 

1.1 MEX-12 General Description 
 

MEX-12 is a standalone unit allowing phone books exchange between cellular mobile devices 
by providing a smart data link between them. And MEXBAT Phone Book Handler Software, 
running on PC and communicating with the MEX-12 unit, gives an easy way to modify, to store 
and to print phone books of mobile devices. 
 
The MEX-12 unit is useful for cellular mobile device sale and service centers, to provide high-
quality services to users of a wide range of mobile terminals operating in different cellular 
networks as TDMA, CDMA, GSM, AMPS. 
 
Note: 
The MEX-12 unit does not modify any NAM settings of mobile devices set by the mobile 
devices’ vendors or cellular network operators. The operation of the MEX-12 unit is 
limited by memory areas of mobile devices allowed for modifying by users of the 
devices. 
 
1.2 MEX-12 Features 

 
• Standalone operation while phone books exchanging without need to use a PC. 
• Supports a wide range of mobile terminals operating in different cellular networks as 

TDMA, CDMA, GSM, AMPS. 
• Supports direct operation with SIM cards used in GSM cellular networks. 
• Phone book handling with MEXBAT program communicating with the MEX-12 unit. 
• Possibility to update the unit’s firmware supporting newer mobile terminals with MEXUP 

Firmware Update Utility via a serial RS-232 link. 
• LCD and five keys Man-Machine Interface allows simple and easy operation. 
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1.3 MEX-12 Physical Description 
 

MEX-12 is the standalone unit that is housed in a plastic handheld cabinet. The unit has the 
following components listed below and marked on the picture. 
 

• Power ON/OFF key. 
• Four menu navigation keys. 
• LCD display for menu and unit status indication. 
• Source Mobile Device terminal. 
• Target Mobile Device terminal. 
• Serial RS-232 terminal. 
• DC power supply terminal. 
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2. Preparation For Use 
 

2.1 MEX-12 Set Content 
 

Please verify before you begin that the content of MEX-12 set contains the following items. 
 

• MEX-12 Mobile Device Memory Exchanger. 
• AC/DC power supply adaptor. 
• A set of labeled cables for different mobile device families. 
• SIM card reader cable. 
• RS-232 serial cable. 
• CD containing MEXBAT Phone Book Handler Software. 
• User manual with a supported mobile device and supplied cables list. 

 
Please report to your local PRAFTEC dealer in case you find some of the listed above items 
damaged or missing. 
 
 
2.2 Turning The Unit ON/OFF 

 
MEX-12 is supplied with an AC/DC 230/50Hz or 110/60Hz power adaptor. 
 
Please follow the following instruction to power ON the unit. 
 

• Verify that the power adaptor contained in the set corresponds your local mains voltage, 
and contact to your local PRAFTEC dealer in case you find them as not corresponding, 
or if you have any difficulties to identify adaptor’s or/and mains’ voltages. 

• Plug the power adaptor in the DC terminal located on right side of the MEX-12 unit. 
• Plug the power adaptor in power mains. 
• Press and hold the ON key until you hear a double beep tones. MEX-12 firmware version 

will be displayed on LCD for a few seconds followed by “Source Device Family” menu. 
The unit is now turned ON and ready for operation. 

 
 

Source Device Family 
   Motorola NAMPS 
   Motorola CDMA 
> Motorola TDMA 
   Nokia 
   Samsung CDMA 
   Samsung TDMA 

 
 
 
Notes: 
Using an improper, or not corresponding to your local mains voltage, power adaptor may 
cause a damage of the adapter and/or MEX-12 unit. 
The menu options of MEX-12 unit may vary with different firmware versions. 
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3. Phone Book Exchange Between Mobile Devices 
 

3.1 Source and Target Devices Selection 
 

Before phone book transferring, source and target mobile devices should be selected as 
described below. 
 
Scroll with “up”/”down” keys of the “Source Device Family“ menu, and select by pressing “->” 
key a device family that you are going to upload phone book from. 

 
Source Device Family 
   Motorola NAMPS 
   Motorola CDMA 
   Motorola TDMA 
> Nokia 
   Samsung CDMA 
   Samsung TDMA 

 
 
After a device family selected, a “Source Device” menu will appear on the LCD. Select a device 
of the family by pressing “up”/”down” and “->” keys. 

 
Source Device  
   Nokia 2120+ 
   Nokia 2160 
   Nokia CDMA 328x 
> Nokia 3320/3360 
   Nokia GSM 51xx 

 
 
By the similar way select a target device family by “Target Device Family” menu. 

 
Target Device Family 
   Motorola NAMPS 
   Motorola CDMA 
   Motorola TDMA 
   Nokia 
> Samsung CDMA 
   Samsung TDMA 

 
 
And a target device by “Target Device” menu. 

 
Target Device  
   SCH-411 
   SCH-611 
> SCH-811 
   SCH-822 
   SCH-911 
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3.2 Source And Target Devices Connections 
 

As soon as a target device has been selected the following menu will appear on the LCD, 
prompting you to connect appropriate cables between the MEX-12 unit and the mobile devices. 
 
In order to return to the main menu, the “<-” key should be pressed. 

 
<- Source Cable XX  
Target Cable XX -> 
<-STOP   PC   START-> 

 
 

• Connect a source mobile device to the Source Terminal located on the left side of the 
MEX-12 unit with a cable marked with the same number as indicated on LCD “Source 
Cable XX”, where XX is the cable number. 

• Connect a target mobile device to the Target Terminal located on the right side of the 
MEX-12 unit with a cable marked with the same number as indicated on LCD “Target 
Cable XX”, where XX is the cable number. 

 
Important notes: 
 
Make sure that only one source mobile device, and only one target mobile device are 
connected to the MEX-12 unit in accordance with your device selections. 
 
Each mobile device requires to be either in ON or in OFF state, depending on its model, 
before starting phone book transferring procedure. Please check MEX-12 supported 
mobile devices list for a proper device state, and turn each device in corresponding state 
before activation phone book transferring procedure. 
 
Mobile devices those are you going to exchange data between, should be equipped with 
fully charged and properly functioning batteries. 
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3.3 Data Exchange Between Mobile Devices 
 

In order to activate data exchange between two selected mobile devices, press “->” key. The 
following messages will appear on LCD, indicating that the data exchanging is in progress. 

 
 

        Source Device 
 

       Data Uploading 
 

         Target Device 
 

          Data Loading 
 

      Data exchanging 
           completed 
<-Next                Finish-> 

 
 
As soon as process will be finished you will be prompted to repeat or to finish data exchange. 
 
Press “->” key in order to finish. 
Press “<-” key in order load the data to the next mobile device of the same model. 
 
Important Note: 
 
Remove battery of its compartment and insert it back in each mobile device after data 
exchanging and before its further use. 
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4. SIM Card Handling 
 

Mobile devices operating in GSM networks use SIM Card (Subscriber Identity Module) that 
contains a subscriber’s identification information and provides a data storage room for user data 
including its phone book. 
 
Phone book of a GSM mobile device stored in SIM card may be handled directly by using SIM 
card reader cable connected to the MEX-12 unit. In order to exchange data between SIM cards, 
or between a SIM card and a mobile device please perform the following procedures. 
 

• Put a SIM card into the plastic SIM holder provided with the SIM card reader cable. 
• Insert the holder with SIM card into the SIM card reader. 

 

 
 

  

• Connect the SIM card reader cable to either Source or Target terminal of the MEX-12 unit 
depending a direction you are going to exchange data on. 

• Select SIM option in either “Source Device Family” or in “Target Device Family” menu 
depending on Source or Target terminal of MEX-12 the SIM is connected to. 

• Data exchange procedure for SIM is similar to the procedure for mobile device. Perform 
further steps in the same way as described in paragraph 3. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

PRAF Microcomputer Technologies Ltd.                                                                                                         MEX-12 Mobile Device Memory Exchanger User Manual.  
                                                                                                                Page 10 of 19 
 

5. MEXBAT Phone Book Handler Software 
 

5.1 Program Functionalities 
 

MEXBAT program allows mobile devices’ phone books handling with a personal computer. The 
program provides the following functionalities making the handling procedures simple and easy 
with its friendly Graphic User Interface. 
 

• Phone book uploading with the MEX-12 unit and storing it as MEX-Base file (.mxb). 
• Phone book loading with the MEX-12 unit to mobile devices. 
• Phone book modifying. 
• New phone book creation. 
• Phone book printing. 

 
 
 
5.2 Program Installation 

 
MEXBAT program requires IBM compatible PC with minimum hardware requirements and with 
a Windows operation system installed on. The following regular steps should be performed in 
order to install the program on a PC. 
 

• Insert the MEXBAT CD into CD-ROM drive. 
• Run an installation program and follow its interactive installation instructions. 
• You will be prompted to run the program as soon as installation finished. 
• The program will add MEXBAT icon to desktop and into the “Programs” folder of the 

Windows start menu. 
• The program may be uninstalled by running uninstall utility contained in the MAXBAT 

folder. 
  
See “readme” file for additional recommendations if you have any problem while installing or 
using MEXBAT program, and contact your local PRAFTEC dealer in case you have further 
problems. 
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5.3 Phone Book Uploading 
 

The following procedures should be performed in order to upload a phone book from a mobile 
device or from a SIM card. 
 

• Connect serial terminal of MEX-12 unit to a free COM port of PC with RS-232 serial cable 
supplied in the MEX-12 set. 

• Run MEXBAT program and activate “Settings” dialog window located in menu “Options”. 
In the “Settings” window, set a proper COM port number you are going to use for the 
serial link between MEX-12 unit and PC. 

• Select Source mobile device in the MEX-12 menus, and connect a source device with its 
corresponding cable, or SIM card reader, as described in paragraph 3. 

• As the following menu has appeared on the LCD, activate data uploading from the mobile 
device or SIM to PC by selecting “Upload Data” option of “Mobile Device” menu of the 
MEXBAT program. 

 
 

SOURCE
DEVICE

MEX12

PC

DEVICE

MEXBAT

TARGET

 
 

 
<- Source Cable XX  
Target Cable XX -> 
<-STOP   PC   START-> 

 
The following messages on LCD will indicate that data uploading is in progress, and the process 
finishing. Repeat the data uploading procedure if you wish to upload data from the next device 
of the same model, and press “->” key in order to finish or to select another model of source 
device. 

 
            MEXBAT 

 
        Data uploading 

 
            MEXBAT 
  Uploading completed 
      Press -> to Finish 
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5.4 Phone Book Loading 

 
The following procedures should be performed in order to Load a phone book to a mobile device 
or to a SIM card. 
 

• Connect serial terminal of MEX-12 unit to a free COM port of PC with RS-232 serial cable 
supplied in the MEX-12 set. 

• Run MEXBAT program and activate “Settings” dialog window located menu “Options”. In 
the “Settings” window, set a proper COM port number you are going to use for the serial 
link between MEX-12 unit and PC. 

• Select Target mobile device in MEX-12 menus, and connect a target device with its 
corresponding cable, or SIM card reader, as described in paragraph 3. 

• As the following menu has appeared on the LCD, activate data loading to the mobile 
device or to SIM from PC by selecting “Load Data” option of “Mobile Device” menu of the 
MEXBAT program. 

 
 

<- Source Cable XX  
Target Cable XX -> 
<-STOP   PC   START-> 

 
 
The following messages on LCD will indicate that data loading is in progress, and the process 
finishing. 
 

 
            MEXBAT 

 
         Data loading 

 
            MEXBAT 
    Loading completed 
      Press -> to Finish 

 
 
Repeat the data loading procedure if you wish to load data to the next device of the same 
model, and press “->” key in order to finish or to select another model of target device. 
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5.5 Contact Data Record Modifying 

 
The following procedures should be performed in order to modify a contact data record. 
 
Double click on a contact that you wish to modify, or activate the “Modify Contact” option at 
“Edit” menu of the MEXBAT program. 
The following window will appear allowing you to modify data of the contact. 
 

 
 

Click “OK” button after all required data modifications have been performed, or “Cancel” button if 
you wish to leave the contact record unchanged. 

 
 
5.6 Contact Data Record Adding 

 
Activate the “New Contact” option of the “Edit” menu of the MEXBAT program in order to create 
a new contact data record, enter a required data, and confirm the contact creation by clicking 
“OK” button, or cancel the session. 

 
 
5.7 Contact Data Record Deletion 

 
Select one or more contacts and activate the “Delete Contact” option of the “Edit” menu of the 
MEXBAT program in order to delete contact data record(s), and confirm the deletion by clicking 
“OK” button, or cancel the session. 
 
Note: 
The deleted contact data records will be totally removed of their contact list (phone book). This 
may change some contact numbers by their shifting to new positions in the contact list. 
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5.8 Contact Data Record Reserving 

 
Select one or more contacts and activate the “Clear Contact” option of the “Edit” menu of 
MEXBAT program in order to clear data record(s) and to reserve the record(s) in the contact list, 
and confirm the contact clearing by clicking “OK” button, or cancel the session. 
 
Note: 
The reserved and cleared data records will be kept of their positions in the contact list. This may 
be useful for users who wish to track the quick dial contact numbers.  

 
 
5.9 Phone Number Prefix Modifying 

 
Phone number prefix modifying may be used in order to adjust a phone book numbers if area 
code, access code or international roaming numbers are changed.  
 
Activate the “Change Prefixes” option of the “Contact List” menu of MEXBAT program in order 
to modify phone number prefixes in a phone book. The “Prefixes” window will appear allowing to 
define a prefix definition file you are going to create and/or modify. 
 

• Use “Edit” button to edit a prefix definition. 
• Use “Add” button to add a prefix definition. 
• Use “Save” button to save a prefix definition file. 
• Use “Apply” button to apply changes to a selected definition file. 
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By pressing the “Edit” button, the “Prefix Change Definition” window will appear and you will 
prompted to enter original and new prefixes as described below. 
 

• Enter an original prefix in the “Prefix to change” text box, and follow this prefix by the 
number of asterisks that equal to the number of digits following the original prefix. 

• Enter a new prefix in the “New Prefix” text box, and confirm the prefix modifying by 
clicking “OK” button, or cancel the session. 

 

 
 

 

This example illustrates how the prefix “03” followed by a number of seven digits is replaced by 
the new prefix “054”. A complete length of the number will be changed from nine to ten digits. 
 
Number with the original prefix: 
Number with the modified prefix: 

 
  03-9876543 
054-9876543 

 
 
5.10 Phone Book Opening and Saving 

 
Phone books are stored as MEX-Base (MXB) files on computer. 
Use the regular procedures in order to open or save the files by activating corresponding 
options in the “File” menu of the MEXBAT program. 

 
 
5.11 Phone Book Printing 

 
Select a phone book you are going to print and activate 
the “Print” option in the “File” menu of MEXBAT program in 
order to print the phone book. If no phone book was 
selected, you will be prompted to enter user name or user 
phone number to identify a user whose phone book you 
are going to print.  

 
Use “Printer Properties” and “Print Preview” options to setup a proper printing format. 
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6. MEX-12 Unit Firmware Update Utility 

 
MEX-12 firmware is continuously developed to enable supporting of new mobile devices models 
and to improve the product. 
 
MEX-12 firmware may be updated with a MEXUP Firmware Update Utility if you have MAXBAT 
v1.xx, or with MEXBAT program v2.xx and its later versions those have the MEXUP utility 
integrated in the program. 
 
Please contact your local PRAFTEC dealer if you wish to obtain a list of new supported devices, 
and MEXUP Firmware Update CD with a latest firmware version. 
 
MEXUP Firmware Update CD contains the following items. 
 

• MEXUP Firmware Update Utility. 
• MEXBAT Phone book Handler Software. 
• A new version of MEX-12 firmware (a file as “mx12-xxx.mex”). 
• A mx12-xxx.txt file describing the x.xx firmware version features and containing 

supported mobile devices list. 
 
In order to update MEX-12 firmware, please follow the following instruction. 
 

• Install the MEXUP Utility on your PC (refer mexup.txt file for details) or activate it by 
clicking on MEXUP menu of the MEXBAT program of v2.xx and later. 

• Connect MEX-12 to a COM port of the PC with RS-232 serial cable. 
• Make sure that MEX-12 unit is powered ON. 
• Run the MEXUP Utility, and you will be prompted to select a COM port number. 
• Select the port number that is used to link the MEX-12 unit and PC. 
• Select the firmware file (“mx12-xxx.mex”) and press “Load” button. A progressing scale 

will indicate that the firmware loading is in progress (it may take about 5 min). 
• After the firmware loaded, perform MEX-12 hardware reset by disconnecting and 

reapplying power to the unit. 
 
Note: If the loading process interrupted the MEX-12 will not function properly. Please 
repeat and finish a firmware loading in case the process was interrupted by some reason. 
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7. Troubleshooting 

 
7.1 Common Troubleshooting Notes 

 
The most problems of data exchange between mobile devices are caused by improper 
interconnection of the devices, or by incorrect functioning of the devices. 
 
If an error has place the MEX-12 unit will notify you for that with the following messages. 

 
      Uploading Failed! 
       Check Cable XX 
<-Next                Finish-> 

 
        Loading Failed! 
       Check Cable XX 
<-Next                Finish-> 

 
 
Data exchange errors may be caused by the following reasons. 
 

• A mobile device is damaged or its battery is not charged nor functioning properly. 
• An improper or damaged AC/DC adaptor is used to supply power to MEX-12 unit. 
• Incorrect or damaged cables are used to interconnect devices. You should check each 

cable in accordance with required cable number indicated on LCD and its actual number. 
• A mobile device is not in a proper ON/OFF state before starting data exchange. You 

should check MEX-12 supported mobile devices list for a proper device state, and turn 
each device in corresponding state, neither ON or OFF, before activation phone book 
transferring procedure. 

• A mobile device is locked by a security code (PIN, Lock Code, etc.). You should unlock 
the device before activation phone book transferring procedure. 

 
 
 
7.2 Mobile Device Specific Troubleshooting Notes 

 
Motorola TDMA: 
 

• The MEX-12 unit may instruct you with a message on its LCD to press #69# key 
sequence on a source mobile device, and #801# key sequence on a target mobile 
device. If so, press # key, and hold it pressed for about three seconds, and then 69# key 
sequence for the source device and 801# key sequence for the target device. 

• Originally cable #1 should be used for operation with Motorola TDMA 7797 mobile 
device. However, if data exchange with the device failed and the device simultaneously 
turns itself ON and OFF, you should use the cable #2 instead. 

 
Panasonic: 
 

• A Panasonic device must be connected to MEX-12 unit being in OFF power state, and be 
powered ON only after all the required cable connections had been performed. 

• Clear phone book of a Panasonic device manually with its menu “Phone Book” options 
before a new phone book loading into the device. 
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8. Legal Notes 

 
This document refers to the MEX-12 Mobile Device Memory Exchanger and to the MEXBAT 
Phone Book Handler Software (the product), as the product’s operation manual intended to help 
its users to use the system. 
 
Copyright Notice 
 
Copyright © PRAF Microcomputer Technologies Ltd. (2004) All rights reserved. 
All the trademarks if mentioned herein are property of their respective owners. 
 
Disclaims 
 
PRAF Microcomputer Technologies Ltd. (PRAFTEC) continuously works in order to improve the 
MEX-12 system’s performance and features. This document and any system features, including 
hardware and software of the product, are subject to be changed without prior notice. 
 
In no event shall PRAFTEC be liable to any party for any loss of profits, loss of business, loss of 
use of data, interruption of business, or for direct, indirect, special or exemplary, incidental, 
punitive or consequential damages of any kind in connection with this document or the 
information contained herein, in connection with use of or deal with the product, even if advised 
of the possibility of such loss or damage. 
 
Warranty 
 
In the event that the product proves to be defective within a period of one year from a date of 
shipment, PRAFTEC shell repair or change the product at its discretion and all possible delivery 
services expenses will be covered exclusively by dealer, distributor or user of the product. 
 
The warranty will be void for malfunctions caused by fire, accident, neglect, abuse, improper 
usage, applying an improper electrical power, attempt to repair the product by anyone other 
than PRAFTEC authorized personnel. 
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